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GETTING STARTED GUIDE

NI Digital Multimeters
This document contains English and Japanese language instructions.

This document explains how to install, configure, test, and set up the NI PCMCIA-4050, 

NI PXI/PCI-4060, NI PXI/PCI/PCIe/USB-4065, NI PXI/PCI-4070, NI PXI-4071, and NI PXI-4072 

National Instruments digital multimeters (DMMs) for common measurements.

For more information on these DMMs, such as features and programming information, refer to the 

NI Digital Multimeters Help, which is located at Start»All Programs»National Instruments»

NI-DMM»Documentation»NI Digital Multimeters Help. For the most current versions of 

specifications and other documentation, visit ni.com/manuals. For the latest version of NI-DMM 

driver software, visit ni.com/idnet.
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Conventions

The following conventions are used in this manual:

 » The » symbol leads you through nested menu items and dialog box options to a final action. 

The sequence File»Page Setup»Options directs you to pull down the File menu, select the 

Page Setup item, and select Options from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to avoid injury, data loss, 

or a system crash. When this symbol is marked on a product, refer to the Read Me First: Safety 

and Radio-Frequency Interference document included with the device for precautions to take.

This icon, and this symbol marked on a product, denotes a hot surface, which indicates a 

device may be hot. Touching this device may result in bodily injury.

bold Bold text denotes items you must select or click in the software, such as menu items and dialog 

box options. Bold text also denotes parameter names.

italic Italic text denotes variables, emphasis, a cross-reference, hardware labels, or an introduction 

to a key concept. Italic text also denotes text that is a placeholder for a word or value you must 

supply.

monospace Text in this font denotes text or characters you should enter from the keyboard and 

programming examples. This font also is used for proper names of disk drives, paths, 

directories, programs, and filenames.

monospace Italic text in this font denotes placeholder text for a word or value you must supply.

italic

NI 4050 Refers to the NI PCMCIA-4050.

NI 4060 Refers to the NI PXI/PCI-4060.
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NI 4065 Refers to the NI PXI/PCI/PCIe/USB-4065.

NI 4070 Refers to the NI PXI/PCI-4070.

NI 4071 Refers to the NI PXI-4071.

NI 4072 Refers to the NI PXI-4072.

NI 407x Refers to the NI 4070, NI 4071, and NI 4072.

DMM Digital multimeter—refers to the NI PCMCIA-4050, NI PXI-4060, NI PCI-4060, 

NI PXI-4065, NI PCI-4065, NI PCIe-4065, NI USB-4065, NI PXI-4070, NI PCI-4070, 

NI PXI-4071, or NI PXI-4072.

PCI Express A version of PCI that maintains the PCI software usage model and replaces the physical bus 

with a high-speed (2.5 Gb/s) serial bus serving multiple lanes.

Platform Text in this font denotes a specific platform and indicates the text following it applies only to 

that platform.

PXI Express A PXI module compatible with existing PXI slots and PXI hybrid slots. PXI Express 

compatible compatible modules maintain hardware and software compatibility, with the exception of

module local bus.

1. Verifying the System Requirements

To use NI-DMM, your system must meet certain requirements. For more information on minimum 

system, recommended system, and supported application development environments (ADEs), refer to 

the NI-DMM Readme file. Before installing NI-DMM, access this file on your NI-DMM driver software 

CDs. After you install NI-DMM, you can access this file at Start»All Programs»National 

Instruments»NI-DMM»Documentation.

Note Waveform acquisition performance at full rate (1.8 MS/s) on the NI 407x depends highly on 

system-specific factors such as CPU speed, memory architecture, and system chipset characteristics. 

Simultaneous acquisitions on multiple NI 407x devices or acquisitions of longer durations require a 

faster processor or more memory. Other applications running at the same time also can affect 

performance.
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2. Unpacking

(PCI, PCI Express, and PXI devices) The DMM ships in an antistatic package to prevent electrostatic 

discharge (ESD). ESD can damage several components on the DMM.

Caution Never touch the exposed pins of connectors. 

To avoid damage while handling the DMM, take the following precautions:

• Ground yourself using a grounding strap or by touching a grounded object.

• Touch the antistatic package to a metal part of the computer chassis before removing the DMM 

from the package.

Remove the DMM from the package and inspect it for loose components or any sign of damage. Notify 

NI if the DMM appears damaged in any way. Do not install a damaged DMM into the computer or 

chassis.

Store the DMM in the antistatic envelope when not in use.

(USB devices) Remove the USB DMM from the package and inspect it for loose components or any sign 

of damage. Notify NI if the DMM appears damaged in any way. Do not install a damaged DMM. 

Caution Treat the USB DMM device as you would any static sensitive device. Always properly 

ground yourself and the equipment when handling the USB DMM device or connecting to it.

3. Verifying the Kit Contents

To set up and use the DMM, you need the following items from the shipping kit:

❑ NI 4050, NI 4060, NI 4065, or NI 407x

❑ Test probes

❑ USB cable (USB devices only)

❑ NI-DMM instrument driver DVD-sized case, containing the NI-DMM driver software CDs, 

which include the NI Digital Multimeters Help and the NI-DMM Readme File

❑ Other included documents:

– NI Digital Multimeters Getting Started Guide

– Specifications document included with the DMM

– Read Me First: Safety and Radio-Frequency Interference
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Other Required Items
In addition to the kit contents, you also need the following:

❑ 1/8 in. flathead screwdriver

❑ One of the following configurations:

– (PCI devices)—A desktop computer with its documentation and one available PCI slot.

– (PCI Express devices)—A desktop computer with its documentation and one available x1, x4, 

x8, or x16 PCI Express slot.

– (USB devices)—A desktop or laptop computer with its documentation and one available 

USB 2.0 or 1.1 compliant slot.

– (PXI devices)—A PXI, PXI/CompactPCI, or PXI/SCXI combination chassis, chassis 

documentation, and a controller.

Note If you are using a MXI interface to control a PXI chassis and encounter performance or 

initialization issues, refer to your MXI documentation to ensure that the MXI interface is properly 

set up. Software optimization might be necessary. For MXI-3 optimization, select Start»

All Programs»National Instruments MXI-3»MXI-3 Optimization. The MXI-4 hardware 

automatically performs MXI-4 optimization.

4. Installing the Software

Before installing the DMM, complete the following steps to install the software:

1. (Optional) Install an application development environment (ADE), such as LabVIEW or 

LabWindows™/CVI™, if you are developing an application for the DMM.

2. Install the latest service packs for your operating system.

3. Insert Disk 1 of 2 of the NI-DMM CD set into the CD drive. The NI-DMM installer should open 

automatically. If the installation window does not appear, navigate to the CD drive, double-click 

the drive, and double-click setup.exe.

4. Follow the instructions in the installation prompts.

(Windows Vista) Users may see access and security messages during installation. Accept the 

prompts to complete the installation.

5. When the installer completes, a dialog box appears and asks if you want to restart, shut down, 

or restart later. Select Restart.

6. If you are using a system running the LabVIEW Real-Time Module, download NI-DMM to 

the target using Measurement & Automation Explorer (MAX). For information about which 

DMMs the LabVIEW Real-Time Module supports, refer to the NI-DMM Readme file at Start»

All Programs»National Instruments»NI-DMM»Documentation. Refer to the Measurement & 

Automation Explorer Remote Systems Help by selecting Help»Help Topics»Remote Systems 

in MAX.
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5. Installing the Hardware

Cautions Unless you are using a USB device, you must power off the PC or PXI chassis before 

installing the DMM hardware.

To prevent damage due to ESD or contamination for all PXI, PCI, and PCI Express devices, handle 

the DMM by the metal bracket or edges. Refer to the Read Me First: Safety and Radio-Frequency 

Interference document for more information.

Notes Install the NI-DMM software before installing the hardware.

Refer to the Appendix B: Chassis Recommendations and System Considerations section for more 

information about installing the DMM in a PC or PXI chassis.

Installing a PXI DMM
To determine if your DMM is a PXI or PXI Express compatible DMM, refer to Figure 2. To install a 

PXI DMM, refer to Figure 1 and complete the following steps.

Figure 1.  PXI Installation

1. Power off and unplug the PXI chassis.

2. Slide the PXI DMM into an available slot until the ejector handle locks in the up position, and 

tighten the captive screw(s).

3. Plug in and power on the PXI chassis.

1 PXI Chassis 2 Ejector Handle 3 Captive Screw 4 PXI DMM

NI PXI-1042

2

3
4

1



© National Instruments Corporation 7 NI Digital Multimeters Getting Started Guide

Installing a PXI Express Compatible DMM
To determine if your DMM is a PXI or PXI Express compatible DMM, refer to Figure 2. To install a PXI 

Express compatible DMM, refer to the Installing a PXI DMM section using a PXI Express compatible 

slot.

Note Refer to your PXI chassis documentation to determine which slots are PXI Express 

compatible.

Figure 2.  PXI DMM and PXI Express Compatible DMM

Uninstalling a PXI DMM

Hot Surface During operation, the metal surfaces of PXI DMMs may exceed safe handling 

temperatures and cause burns. Allow the DMM to cool before removing it from the chassis or when 

moving it to a different peripheral slot. When removing the DMM, hold it by the ejector handle and 

front panel only.

When removing a PXI DMM from the chassis, ensure you are grounded with a grounding strap or are 

touching a grounded metal surface. To avoid ESD, do not touch the exposed connector pins or any 

exposed circuitry on the device. When not in use, store the PXI DMM in the original antistatic envelope 

to avoid damage.

1 PXI DMM 2 PXI Express Compatible DMM

21
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Installing a PCI DMM
To install a PCI DMM, refer to Figure 3 and complete the following steps.

Figure 3.  PCI Installation

1. Power off and unplug the PC.

2. Remove the PC cover.

3. Insert the PCI DMM into an open PCI slot.

4. Secure the PCI DMM with the screw provided.

Caution It is important to completely screw the DMM into the PCI slot for both mechanical stability 

and to create a solid ground connection, which will reduce electrical noise. Improperly secured 

DMMs may affect the accuracy of the specifications.

5. Replace the PC cover.

6. Plug in and power on the computer.

1 PCI DMM 2 PCI Slot 3 Desktop Computer

2

3

1
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Installing a PCI Express DMM
To determine PCI Express slots, refer to Figure 4. To install a PCI Express DMM, refer to the Installing 

a PCI DMM section using any PCI Express slot.

Figure 4.  PCI Express Slots

Installing a USB DMM
To install a USB DMM, refer to Figure 5, and connect the USB cable to the PC and DMM.

Note The LED next to the USB connector of the device will be lit with a solid green light once the 

PC loads the driver for the device.

Figure 5.  USB Installation

1 PCI Express x1 Slot
2 PCI Express x4 Slot

3 PCI Express x8 Slot
4 PCI Express x16 Slot

1 Laptop Computer 2 USB DMM 3 USB Cable 4 LED

2

3

4

1

2

1

3
4
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USB Cable Strain Relief

You can choose between two strain relief options for your USB DMM:

• Cable Strain Relief Groove Method—Press the USB cable into one of the two grooves on the 

underside of the USB device. Choose the USB cable groove that matches your USB cable size, as 

shown in Figure 6.

• Zip Tie Method—Thread a zip tie through the zip tie bar on the underside of the USB device and 

tighten around the USB cable, as shown in Figure 6.

Figure 6.  USB Cable Strain Relief Options

USB Ground Lug

(Optional) Connect the chassis ground to the ground lug. The ground lug protects your laptop or desktop 

from transient potential, which could affect the measurement inputs of the USB device. Refer to 

Figure 20 for the location of the USB ground lug.

1 Cable Strain Relief Groove Method
2 Zip Tie Method
3 USB Cable Strain Relief Groove (Large)
4 USB Cable Strain Relief Groove (Small)

5 USB Cable
6 Zip Tie
7 Zip Tie Bar

3

4

5

5

7

6

21
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Using the USB DMM on a Desktop

Note The plastic guides on the underside of the USB DMM allow stacking on top of other National 

Instruments USB devices, such as the NI USB-5133 high-speed digitizer. Do not apply the rubber 

feet if you are stacking the USB DMM on top of another National Instruments USB device.

For secure desktop use, adhere the supplied rubber, non-skid feet to the underside of the device, 

as shown in Figure 7.

Figure 7.  Applying Rubber Feet to the USB DMM

1 USB DMM 2 Plastic Guides 3 Rubber Feet

2

2

1

3
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Panel Mounting the USB DMM

To mount the USB DMM on a board or panel, complete the following steps while referring to Figure 8.

Figure 8.  Mounting the USB DMM on a Panel

Notes Do not apply the rubber feet to the USB DMM when panel mounting.

Apply strain relief, as described in the USB Cable Strain Relief section, before panel mounting.

1. Download and print the panel mounting template PDF attached in the KnowledgeBase document. 

Go to ni.com/info and enter the info code rd3233 to locate the KnowledgeBase.

2. Using the template, mark the bottom point and top point on the panel. The points will be 162 mm 

(6.375 in.) apart.

3. Remove the USB cable from the connector on the USB DMM.

4. Screw a #8 or M4 screw into the bottom point on the panel.

5. Set the USB DMM on the screw by fitting it into the bottom screw notch on the underside of 

the device.

6. Screw a #8 or M4 screw through the USB DMM top screw hole into the panel.

1 Top Screw Hole 2 Bottom Screw Notch

2

1
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Installing a PCMCIA DMM
To install the PCMCIA DMM, insert the PCMCIA DMM into an available PCMCIA slot as shown in 

Figure 9.

Figure 9.  PCMCIA Installation

6. Windows Device Recognition

Windows recognizes any newly installed device the first time the computer reboots after hardware is

installed. On some Windows systems, the Found New Hardware wizard opens with a dialog box for

every NI device installed. Install the software automatically (Recommended) is selected by default.

Click Next or Yes to install the software for each device.

Note (USB devices) When you first install your USB DMM, Windows will recognize a new device. 

Click Next on any dialog boxes that appear to complete the installation.

After Windows recognizes newly installed NI USB devices, a dialog box prompts you to select from the 

following options, which may vary depending on the devices and software installed on your system:

• Begin a Measurement with This Device Using NI LabVIEW SignalExpress opens LabVIEW 

SignalExpress.

• Use This Device Interactively launches the NI-DMM Soft Front Panel (SFP).

• Begin an Application with This Device launches LabVIEW.

• Configure and Test This Device opens MAX to your device so you can configure settings.

• Take No Action leaves your device in the system but does not launch an application.

1 Laptop 2 PCMCIA Slot 3 NI 4050

2

3

1
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7. Configuring and Testing in MAX

To configure and test the DMM in MAX, complete the following steps:

1. Launch MAX (Start»All Programs»National Instruments»Measurement & Automation). 

MAX automatically detects the DMM you installed.

2. Expand Devices and Interfaces.

If you are using a DMM with the LabVIEW Real-Time Module, expand Remote Systems. Find 

the target device IP address or name, expand it, and then expand Devices and Interfaces.

Note Only NI-DAQmx devices are listed under Remote Systems»Devices and Interfaces.

(Windows Vista) Windows Vista does not support Traditional NI-DAQ (Legacy) for DMMs. Refer 

to the Supported Hardware section of the NI-DMM Readme file at Start»All Programs»National 

Instruments»NI-DMM»Documentation to determine which operating system is compatible with 

your DMM.

3. Verify that the DMM appears under Devices and Interfaces.

The DMMs appear in the NI-DAQmx and Traditional NI-DAQ (Legacy) folders in Devices and 

Interfaces, as follows.

Notes If the DMM is not listed, press <F5> to refresh. If the DMM is still not listed, repeat the steps 

in the 5. Installing the Hardware section. If the DMM still does not appear, visit NI Technical 

Support at ni.com/support. For more information about using MAX, refer to the available help 

files within MAX.

The NI PXI-4070 is supported by both NI-DAQmx and Traditional NI-DAQ (Legacy). When present 

with both versions of NI-DAQ, the NI PXI-4070 is listed with a different name under the NI-DAQmx 

and Traditional NI-DAQ (Legacy) folders in Devices and Interfaces.

Device Folder Name(s)

NI 4065, NI PCI-4070, NI 4071, NI 4072 NI-DAQmx

NI PXI-4070 NI-DAQmx and Traditional NI-DAQ (Legacy) *

NI 4050, NI 4060 Traditional NI-DAQ (Legacy) *

* Windows Vista does not support Traditional NI-DAQ (Legacy) for DMMs.
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4. Record the device number or device name assigned to the DMM. You need this when programming 

the DMM.

• (NI-DAQmx devices) The assigned device name is appended to the DMM in its configuration 

tree label. For example, after installing the NI PXI-4070, the device configuration tree label 

may appear as NI PXI-4070: "Dev1", where Dev1 is the device name that MAX assigned 

to the DMM. When developing your application, the resource name for the DMM is this 

device name.

• (Traditional NI-DAQ (Legacy) devices) Select the DMM to see its properties in the configuration 

view. The device number appears in the Values column. When developing your application, 

the resource name for the DMM is DAQ::n, where n is the device number MAX assigned to 

the DMM.

Note To avoid modifying existing applications that use a Traditional NI-DAQ (Legacy) device 

number, change the assigned NI-DAQmx device name. To change an NI-DAQmx device name, 

right-click the DMM, select Rename, and enter the Traditional NI-DAQ (Legacy) device number 

used in your application. For more information about device naming conventions, refer to the 

niDMM Initialize or niDMM_init topic in the NI Digital Multimeters Help located at Start»All 

Programs»National Instruments»NI-DMM»Documentation»NI Digital Multimeters Help.

5. Perform a self-test on the DMM to verify installation.

• (NI-DAQmx devices) Right-click the DMM and select Self-Test. If you need help during the 

self-test, open the Measurement & Automation Explorer Help for NI-DAQmx by selecting 

Help»Help Topics»NI-DAQmx»MAX Help for NI-DAQmx.

• (Traditional NI-DAQ (Legacy) devices) Right-click the DMM, select Properties, and click Test 

Resources.

A dialog box appears and indicates whether the DMM passed the test.

Note If the DMM does not pass the test, repeat the steps in the 5. Installing the Hardware section. 

If the DMM still does not pass the test, visit NI Technical Support at ni.com/support.

6. (NI-DAQmx NI 407x devices only) Perform a self-calibration on the DMM. Right-click the DMM and 

select Self-Cal. The DMM must warm up for at least 60 minutes before self-calibrating.

7. Launch the DMM Soft Front Panel to run functional tests and to use the DMM. You can launch 

the DMM SFP from Start»All Programs»National Instruments»NI-DMM»NI-DMM Soft 

Front Panel. 

Note (NI 4050 and NI 4060 only) You can complete the following steps to run the functional test 

panels and to use the DMM. Right-click the NI 4050 and NI 4060 and click Test Panels. Refer to the 

8. Connecting Signals section to connect a signal to the DMM. Click Close to close the test panels 

for the NI 4050 and NI 4060.
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8. Connecting Signals

The following sections explain how to connect signals to the DMM front panel connectors for common 

measurements.

For more information about these common measurements, refer to the NI Digital Multimeters Help at 

Start»All Programs»National Instruments»NI-DMM»Documentation»NI Digital Multimeters 

Help.

Caution Always refer to the specifications document included with the DMM before connecting 

signals. Failure to observe the specified maximum signal ratings can cause shock, a fire hazard, or 

damage to the devices connected to the DMM. NI is not liable for any damage or injuries resulting 

from incorrect signal connections.

DC and AC Voltage

Figure 10.  NI 4050 Signal Connections for Voltage Measurements

Figure 11.  NI 4060, NI 4065, and NI 407x Signal Connections for Voltage Measurements

1 NI 4060 2 NI PXI/PCI/PCIe-4065 and NI 407x 3 NI USB-4065

or
250 V

MAX.

LO

HI

DC AC

orDC AC
orDC AC

or

DC

AC

2 31
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DC and AC Current

Figure 12.  NI 4050 Signal Connections for Current Measurements

Note To measure current, the NI 4050 requires the NI CSM-200mA or NI CSM-10A current shunt 

module (shown in Figure 12), which is available from NI. Refer to the NI CSM-10A/200mA 

Installation Guide at Start»All Programs»National Instruments»NI-DMM»Documentation.

Figure 13.  NI 4060, NI 4065, and NI 407x Signal Connections for Current Measurements

Tip To measure current beyond the specifications of the NI 4060, NI 4065 and NI 407x, NI offers a 

10 A current shunt module, the NI CSM-10A. Refer to the NI CSM-10A/200mA Installation Guide 

at ni.com/manuals for more information. Refer to ni.com/instruments for purchasing 

information.

1 NI 4060 2 NI PXI/PCI/PCIe-4065 and NI 407x 3 NI USB-4065

250 V

MAX.

LO

HI

250 V

MAX.- FUSED

LO

HI

CSM-200mA

200mA SHUNT 1Ω

2 31
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2-Wire Resistance

Figure 14.  NI 4050 Signal Connections for 2-Wire Resistance Measurements
 

Figure 15.  NI 4060, NI 4065, and NI 407x Signal Connections for 2-Wire Resistance Measurements

1 NI 4060 2 NI PXI/PCI/PCIe-4065 and NI 407x 3 NI USB-4065

250 V

MAX.

LO

HI

2 31
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4-Wire Resistance (NI 4060, NI 4065 and NI 407x only)
4-wire resistance measurements use both pairs of terminals. Use the configuration to measure low 

resistances accurately by eliminating the effects of lead resistance.

Note The NI 4050 does not support 4-wire resistance measurements.

Figure 16.  NI 4060, NI 4065, and NI 407x Signal Connections for 4-Wire Resistance Measurements

Capacitance and Inductance (NI 4072 only)

Figure 17.  NI 4072 Signal Connections for Capacitance and Inductance Measurements

1 NI 4060 2 NI PXI/PCI/PCIe-4065 and NI 407x 3 NI USB-4065

1 Capacitance Connections 2 Inductance Connections

2 31

+

21
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Voltage Drop Across a Diode
The DMM can excite a device under test and read the resulting voltage drop, which is useful for testing 

diodes.

 

Figure 18.  NI 4050 Signal Connections for Diode Measurements

Figure 19.  NI 4060, NI 4065, and NI 407x Signal Connections for Diode Measurements

1 NI 4060 2 NI PXI/PCI/PCIe-4065 and NI 407x 3 NI USB-4065

250 V

MAX.

LO

HI

+

–

+

–

+ –

+

–

2 31
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Using Cables and Probes
The DMM shipping kit contains a pair of test probes with safety banana plugs. These probes meet 

international safety requirements, including UL 3111 and IEC 1010-1, for the full range of applications 

supported by the DMM.

Caution Before using any probes or accessories not supplied by NI, ensure that they meet applicable 

safety requirements for the signal levels you may encounter.

Connect the test probes to the banana plug connectors on the DMM front panel using safety banana 

plugs. The shrouds around the banana plugs prevent you from contacting potentially hazardous voltages 

connected to the test probes. You can also connect the cable to standard, unshrouded banana plug probes 

or accessories. Use unshrouded probes or accessories only when the voltages are less than 30 Vrms and 

42 Vpk, or 60 VDC.

Cautions (NI 4050 users) To prevent possible safety hazards, the maximum voltage between either 

of the inputs and the ground of the computer should never exceed ±250 VDC or 250 Vrms.

(NI 4060 users) To prevent possible safety hazards, the maximum voltage between either of the inputs 

and the ground of the computer should never exceed ±300 VDC or 300 Vrms. The maximum 

current the NI 4060 can measure between the current inputs is ±200 mA DC or 200 mArms.

(NI 4065 users) To prevent possible safety hazards, the maximum voltage between either of the inputs 

and the ground of the computer should never exceed ±300 VDC or 300 Vrms. The maximum current 

the NI 4065 can measure between the current inputs is ±3 A DC or 3 Arms.

(NI 4071 users) To prevent possible safety hazards, the maximum voltage between either of the inputs 

and the ground of the computer is 500 VDC or 500 Vpk (sine wave), except between the HI terminal 

and ground, where the maximum voltage is 1,000 VDC or 700 Vrms (sine wave). The maximum 

current the NI 4071 can measure between the current inputs is ±3 A DC or 3 Arms.

(NI 4070/4072 users) To prevent possible safety hazards, the maximum voltage between either of the 

inputs and the ground of the computer should never exceed ±300 VDC or 300 Vrms. The maximum 

current the NI 4070/4072 can measure between the current inputs is ±1 A DC or 1 Arms.

9. Programming the DMM

You can acquire data with the DMM by using the DMM SFP, NI-DMM/Switch Express VI, 

NI LabVIEW SignalExpress, or the NI-DMM instrument driver in your application, and you can 

run the NI-DMM examples to demonstrate the functionality of the DMMs.

DMM Soft Front Panel
The DMM SFP is a software representation of a traditional benchtop DMM. Use the DMM SFP to test 

the basic functionality of the DMM and to become familiar with its operation. You can launch the DMM 

SFP from Start»All Programs»National Instruments»NI-DMM»DMM Soft Front Panel.

NI-DMM/Switch Express VI
The NI-DMM/Switch Express VI configures and acquires a signal using NI-DMM with National 

Instruments digital multimeters and PXI or SCXI switch modules. You can launch the NI-DMM/Switch 

Express VI from LabVIEW 7.x or later.
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NI LabVIEW SignalExpress Limited Edition
NI-DMM 2.7 and later includes a stand-alone, evaluation version of NI LabVIEW SignalExpress that 

allows you to quickly configure your NI hardware to acquire, generate or perform hardware comparison 

using your DMM. LabVIEW SignalExpress LE gives you a 30-day trial of the Full Edition of LabVIEW 

SignalExpress. After that period, you must activate your version of LabVIEW SignalExpress LE, which 

is free, or purchase the Full Edition. If you activate your version of LabVIEW SignalExpress LE before 

your 30-day trial of the Full Edition is complete, the full features are still available for the remainder 

of your 30-day trial.

NI-DMM Instrument Driver
NI-DMM features a set of operations and attributes that exercise all the functionality of the DMM, 

including configuration, control, and other module-specific functions. NI-DMM controls all NI digital 

multimeters.

Refer to the Programming section of the NI Digital Multimeters Help at Start»All Programs»National 

Instruments»NI-DMM»Documentation»NI Digital Multimeters Help for information about using 

NI-DMM in your applications.

NI-DMM Examples
The NI-DMM examples are instructional tools that demonstrate some of the functionality of the DMMs 

you can use or integrate into your systems. NI-DMM includes examples covering single point 

measurements, multipoint measurements, triggering, waveform acquisitions (NI 407x only), and 

performance (NI 407x only).

Tip For best accuracy, NI 407x users should run the Self-Cal example after the DMM has been 

installed and has warmed up.

Refer to the Examples section of the NI-DMM Readme file at Start»All Programs»National 

Instruments»NI-DMM»Documentation for a complete example list. Refer to ni.com/zone 

for examples that use National Instruments DMMs with National Instruments switch modules. 

LabVIEW and LabWindows/CVI users can use the NI Example Finder to search or browse examples. 

NI-DMM examples are classified by keyword, so you can search for a particular device or measurement 

function. 

To browse the NI-DMM examples available in LabVIEW, launch LabVIEW, click Help»Find 

Examples, and navigate to Hardware Input and Output»Modular Instruments»NI-DMM 

(Digital Multimeters).

To browse the NI-DMM examples available in LabWindows/CVI, launch LabWindows/CVI, select 

Help»Find Examples, and navigate to Hardware Input and Output»Modular Instruments»

NI-DMM (Digital Multimeters).
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Appendix A: Front Panels

PXI/PCI/PCI Express/USB
The PXI, PCI, PCI Express front panels have four shrouded banana plug connectors and one 9-pin 

connector. The USB front panel has five shrouded banana plug connectors and one 9-pin connector. 

Refer to Figure 20 for the front panels for the NI 4060, NI 4065, and NI 407x.

Figure 20.  Front Panel Connectors on the PXI, PCI, PCI Express, and USB DMMs

1 NI PCI-4060
2 NI PXI-4060
3 NI PCI/PCIe-4065, NI PCI-4070
4 NI PXI-4065/4070/4071/4072

5 NI USB-4065
6 Banana Plug Connectors
7 9-Pin Auxiliary Connectors

8 Ground Lug
9 LED
10 USB Port
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The banana plug connectors are high-voltage, safety signal connectors. The 9-pin connector labeled 

AUX I/O is a digital signal connector, which carries TTL-level triggering signals for use with external 

scanning equipment. Refer to the NI Digital Multimeters Help, located at Start»All Programs»

National Instruments»NI-DMM»Documentation»NI Digital Multimeters Help, for information 

about scanning.

Note The AUX I/O connector is not isolated. It is not referenced to your measurement circuit. The 

connector is referenced to the ground of your computer. The digital signals on this connector should 

not operate beyond –0.5 to 5.5 V of your computer ground. The trigger signals are TTL-compatible.

PCMCIA

Caution To measure current with the NI PCMCIA-4050, you must use a current shunt module. 

Refer to the 8. Connecting Signals section of this document for more information.

An accessory cable connects the NI PCMCIA-4050 to a pair of test probes equipped with shrouded 

banana plugs. Both the accessory cable and the test probes ship with the NI PCMCIA-4050. The 

accessory cable connector is polarized and cannot be plugged in incorrectly.

Refer to Figure 21 to connect the accessory cable to the NI PCMCIA-4050.

Figure 21.  Connecting Cables and Probes to the NI PCMCIA-4050

1 Laptop Computer
2 PCMCIA Slot

3 Test Probes
4 Accessory Cable

5 NI PCMCIA-4050

2
3

5
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1
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Appendix B: Chassis Recommendations and System Considerations

This appendix specifies the recommended chassis components and conditions for a system that includes 

National Instruments DMMs.

PXI Chassis Recommendations

The NI PXI-4060/4065 and NI PXI-407x are designed to operate in any PXI-compliant chassis. 

Temperature on these DMMs can vary with slot position in the chassis. Complete the following 

recommendations to minimize this temperature variation and ensure normal operating conditions for 

these DMMs:

• Perform routine maintenance of the chassis cooling fan filters, including cleaning. Such 

maintenance ensures continuous cooling effectiveness, keeps dust off the components of the PXI 

DMMs, and ensures accurate high-resistance measurements. NI recommends cleaning the chassis 

fan filters at a maximum interval of six months and keeping the chassis environment clean to 

minimize dust that enters the chassis. For more information about cleaning the chassis fan filters, 

refer to your chassis documentation.

• Install PXI filler panels in all empty slots.

• Verify the PXI chassis fans that provide forced air remain unobstructed and can allow for proper 

cooling of the PXI chassis, devices, and controller.

PXI Express Chassis

Some PXI Express chassis provide hybrid slots. A hybrid slot can accept either PXI Express modules 

or PXI Express compatible modules, but not standard PXI modules.

To determine if your chassis contains hybrid slots, refer to your chassis documentation. For more 

information about hybrid slots, visit ni.com/support, and enter PXI Express FAQ in the Search 

field.

Refer to the PXI Express Compatibility section of the NI Digital Multimeters Help, located at Start»

All Programs»National Instruments»NI-DMM»Documentation»NI Digital Multimeters Help, 

to determine if your DMM is PXI or PXI Express compatible and for more information about 

PXI Express compatibility.

PCI Chassis Recommendations
The NI PCI-4060, NI PCI-4065, and NI PCI-4070 are designed to operate in any ATX-compliant 

industrial or personal computer. Complete the following recommendations to ensure normal operating 

conditions for these DMMs:

Caution For optimal electromagnetic compatibility (EMC) performance and input protection, 

you must install the front panel screw.

• Verify the PCI front panel brackets on the NI PCI-4060, NI PCI-4065, and NI PCI-4070 have 

a firm, direct, metal-to-metal mounting connection for proper grounding. Some computer 

manufacturers use a securing lever made of plastic; such a lever is unacceptable for safety reasons, 

and you must remove it. Also, you must screw down the PCI devices. If the computer chassis does 

not allow you to meet these requirements, you must use a different computer chassis.

• Install all covers for the industrial chassis or personal computer.

• Install PCI filler panels in all unused PCI slots.



NI Digital Multimeters Getting Started Guide 26 ni.com

Additional Recommendations for the NI PCI-4070

The cooling capability of most industrial and personal computers is less than the cooling capability of a 

PXI chassis. The NI PCI-4060 and the NI PCI/PCIe-4065 dissipate low enough power that additional 

cooling is not needed in most computers. The NI PCI-4070 dissipates higher power, and NI strongly 

recommends NI PCI-4070 users implement the following precautions to maximize the cooling 

capability of the computer:

• Install an additional 80 mm, 32 cubic ft/min (CFM) fan that forces air towards the NI PCI-4070. 

Most computer chassis contain one or two mounting locations for this type of fan. These fans are 

inexpensive and readily available at most computer supply stores.

Note If the hard drive mounts vertically in front of the fan mounting location(s) in the computer 

chassis, you must move the hard drive to a horizontal 3.5 in. drive bay or to another suitable location 

that does not obstruct the fan mounting location(s).

• Add additional fans, such as PCI fan cards and chassis fans, to increase the air circulation inside 

the computer.

USB System Considerations
The NI USB-4065 conforms to USB 2.0 specifications and is 1.1 compliant. The NI USB-4065 is a high 

powered USB device that supports both Hi-Speed and full-speed USB protocol. For more information 

about power requirements, refer to the NI 4065 Specifications.

Appendix C: Fuse Replacement

This appendix explains how to replace the fuse in the NI 4060, NI 4065, NI 407x, and 

NI CSM-10A/200mA.

Caution For protection against fire, replace the fuse only with fuses of the same type and rating. 

Refer to Table 1 for fuse types.

Note The NI 4050 does not have a user-replacable fuse.

Table 1.  Appropriate Fuses for the NI 4060, NI 4065, NI 407x, and Current Shunt Modules

DMM Fuse Rating Fuse Type Manufacturer

NI 4060 F 500 mA 250 V Fast-Acting Schurter

F 500 mA 250 V Fast-Acting Littelfuse

NI 4070/4072 F 1.25 A 250 V Fast-Acting Littelfuse

NI 4065, NI 4071 F 3.15 A 250 V Fast-Acting Littelfuse

NI CSM-10A F 12.5 A 250 V Fast-Acting Schurter

NI CSM-200mA F 500 mA 250 V Fast-Acting Schurter
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NI 4060
To replace the fuse, complete the following steps. 

(NI PXI-4060)

1. Remove all front panel connections from the NI PXI-4060.

2. Power down the chassis, and remove the device.

3. View the device at the angle shown in Figure 22, and locate the fuse holder.

Figure 22.  Locating the Fuse on the NI PXI-4060

4. Insert a screwdriver into the slot on the fuse holder.

5. Turn counterclockwise.

6. Pull out the holder, and remove the 5 × 20 mm glass fuse.

7. Verify the fuse is blown by measuring discontinuity across the fuse using another meter.

8. Insert a new fuse into the holder and slide the holder back into place.

9. Turn the fuse holder clockwise until it snaps shut.

1 Fuse Holder

1
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(NI PCI-4060)

1. Remove all front panel connections from the NI PCI-4060.

2. Power off the computer, and remove the device.

3. Remove the four screws that secure the top and bottom insulators onto the device, as shown in 

Figure 23.

Figure 23.  Removing the Insulators from the NI PCI-4060

4. Remove the top and bottom insulators.

1 Screws Securing Insulators 2 Insulators

2

2

1
1

1 1
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5. Locate the 5 × 20 mm glass fuse shown in Figure 24.

Figure 24.  Removing the Fuse from the NI PCI-4060

6. Remove the fuse, and verify the fuse is blown by measuring discontinuity across the fuse using 

another meter.

7. Press the new fuse into the silver holding fixture until you hear a snap.

Caution Do not operate the NI PCI-4060 without both insulators replaced and secured.

8. Reattach the top and bottom insulators in the opposite order you removed them.

1 Glass Fuse

1
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NI 4065

1. Remove all front panel connections from the NI 4065.

• (NI PXI/PCI/PCIe-4065) Power down the chassis, and remove the device.

• (NI USB-4065) Disconnect the USB cable from the NI USB-4065.

2. Locate the fuse holder on the NI 4065.

• (NI PXI-4065) View the device at the angle shown in Figure 25.

• (NI PCI/PCIe-4065) View the device at the angle shown in Figure 26.

• (NI USB-4065) View the device at the angle shown in Figure 27.

Figure 25.  Locating the Fuse on the NI PXI-4065

1 Fuse Holder

1
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Figure 26.  Locating the Fuse on the NI PCI/PCIe-4065

Figure 27.  Locating the Fuse on the NI USB-4065

1 Fuse Holder

1 Fuse Holder

1

1



NI Digital Multimeters Getting Started Guide 32 ni.com

3. Insert a screwdriver into the slot on the fuse holder.

4. Turn counterclockwise.

5. Pull out the holder, and remove the 5 × 20 mm glass fuse.

6. Verify the fuse is blown by measuring discontinuity across the fuse using another meter.

7. Insert a new fuse into the holder and slide the holder back into place.

8. Turn the fuse holder clockwise until it snaps shut.

NI 407x

To replace the fuse, complete the following steps.

(NI PXI-4070/4071/4072)

1. Remove all front panel connections from the NI PXI-407x.

2. Power off the chassis, and remove the NI PXI-407x.

3. Locate the fuse hole shown in Figure 28.

Figure 28.  Removing the Fuse from the NI PXI-407x

4. Insert a screwdriver into the hole.

Caution Do not cover the fuse slot on the opposite side of the NI PXI-407x with your hand, as doing 

so may cause injury.

5. Gently press the fuse with the screwdriver until one of the fuse clamps releases.

1 Screwdriver 2 Fuse Hole

2

1



© National Instruments Corporation 33 NI Digital Multimeters Getting Started Guide

6. Locate the fuse slot shown in Figure 29.

Figure 29.  Removing the Fuse from the NI PXI-407x

7. Pry the fuse loose from the slot.

8. Verify the fuse is blown by measuring discontinuity across the fuse using another meter.

9. Insert a new fuse into the fuse slot as shown in Figure 30.

Figure 30.  Replacing the Blown Fuse in the NI PXI-407x

10. Gently press the fuse with the screwdriver until both fuse clamps snap the fuse into place.

1 Fuse 2 Fuse Slot

1 Fuse 2 Fuse Slot

2

1

2

1



NI Digital Multimeters Getting Started Guide 34 ni.com

(NI PCI-4070)

1. Remove all front panel connections from the NI PCI-4070.

2. Power down the chassis, and remove the device.

3. Hold the NI PCI-4070 at the angle shown in Figure 31, and locate the fuse holder.

Figure 31.  Locating the Fuse on the NI PCI-4070

4. Insert a screwdriver into the slot on the fuse holder.

5. Turn counterclockwise.

6. Pull out the fuse holder, and remove the 5 × 20 mm fuse.

7. Verify the fuse is blown by measuring discontinuity across the fuse using another meter.

8. Insert a new fuse into the holder, and slide the holder back into place.

9. Turn the fuse holder clockwise until it snaps shut.

NI CSM-10A/200mA
To replace the fuse, complete the following steps.

1. Power down all equipment connected to the current shunt module (CSM).

2. Remove all connections from the CSM.

3. Turn the fuse holder counter-clockwise with a flathead screwdriver and pull the fuse holder out to 

expose the fuse in the housing.

1 Fuse Holder

1
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Figure 32.  Removing the Fuse

4. Remove the old fuse.

5. Verify the fuse is blown by measuring discontinuity across the fuse using another meter.

6. Install the new fuse.

7. Push the fuse holder back into the housing and turn it clockwise until it tightens completely.

Appendix D: Where to Go for Support

The National Instruments Web site is your complete resource for technical support. At 

ni.com/support you have access to everything from troubleshooting and application development 

self-help resources to email and phone assistance from NI Application Engineers.

A Declaration of Conformity (DoC) is our claim of compliance with the Council of the European 

Communities using the manufacturer’s declaration of conformity. This system affords the user 

protection for electronic compatibility (EMC) and product safety. You can obtain the DoC for your 

product by visiting ni.com/certification. If your product supports calibration, you can obtain the 

calibration certificate for your product at ni.com/calibration.

National Instruments corporate headquarters is located at 11500 North Mopac Expressway, Austin, 

Texas, 78759-3504. National Instruments also has offices located around the world to help address 

your support needs. For telephone support in the United States, create your service request at 

ni.com/support and follow the calling instructions or dial 512 795 8248. For telephone support 

outside the United States, contact your local branch office: 

Australia 1800 300 800, Austria 43 662 457990-0, Belgium 32 (0) 2 757 0020, 

Brazil 55 11 3262 3599, Canada 800 433 3488, China 86 21 5050 9800, 

Czech Republic 420 224 235 774, Denmark 45 45 76 26 00, Finland 358 (0) 9 725 72511, 

France 01 57 66 24 24, Germany 49 89 7413130, India 91 80 41190000, Israel 972 3 6393737, 

Italy 39 02 413091, Japan 81 3 5472 2970, Korea 82 02 3451 3400, Lebanon 961 (0) 1 33 28 28, 

Malaysia 1800 887710, Mexico 01 800 010 0793, Netherlands 31 (0) 348 433 466, 

New Zealand 0800 553 322, Norway 47 (0) 66 90 76 60, Poland 48 22 3390150, 

Portugal 351 210 311 210, Russia 7 495 783 6851, Singapore 1800 226 5886, 

Slovenia 386 3 425 42 00, South Africa 27 0 11 805 8197, Spain 34 91 640 0085, 

Sweden 46 (0) 8 587 895 00, Switzerland 41 56 2005151, Taiwan 886 02 2377 2222, 

Thailand 662 278 6777, Turkey 90 212 279 3031, United Kingdom 44 (0) 1635 523545
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